
JPSKmail
Руководство пользователя

версии 1.5.7

Copyright (c) 2010-2012 Pär Crusefalk and Rein Couperus
Permission is granted to copy, distribute and/or modify this document
under the terms of the GNU Free Documentation License, Version 1.3
or any later version published by the Free Software Foundation;
with no Invariant Sections, no Front-Cover Texts, and no Back-Cover Texts.
A copy of the license is included in the section entitled "GNU
Free Documentation License".

Неполный перевод выполнен по 
англоязычному руководству пользователя, 
обновлённому 22.02.2012 и описывающему 
программу jPSKmail версии 1.5.7.



Содержание

Краткое описание истории проекта................................................................4
Что такое PSKmail?............................................................................................5
Каковы особенности PSKmail?..........................................................................5
В целом, что же такое PSKmail?.......................................................................6
Что насчёт безопасности в PSKmail?...............................................................6

Установка и начало работы..................................................................................7
Последовательность установки........................................................................7
Необязательный картографический клиент APRS.........................................7
Инструкции по установке RXTX.......................................................................8

Выбор оборудования — не переведено................................................................9
Трансивер...........................................................................................................9
Интерфейс к звуковой карточке......................................................................9
Антенна..............................................................................................................9

Настройка Fldigi..................................................................................................10
Обзор пользовательской программы.................................................................13
Окно параметров.................................................................................................15

Пользовательские данные..............................................................................15
Отправка пароля соединения на сервер.......................................................16
Маячная минута и канал сервера..................................................................16
Выбор подходящих режимов..........................................................................17
Установка таблицы режимов и режима по умолчанию...............................17
Установка режимов работы............................................................................18
Настройки электронной почты......................................................................19
Вкладка Configuration.....................................................................................19
Вкладка Devices...............................................................................................20
Вкладка Modem...............................................................................................21
Запуск fldigi и jPSKmail на раздельных компьютерах..................................22

Вкладки основного окна.....................................................................................23
Вкладка Terminal, работа в подключённом состоянии....................................23

Вкладка Terminal, режим переписки-чата....................................................24
Создание сообщения электронной почты.........................................................25

Подготовка сообщения электронной почты..................................................26
Отправка электронной почты в подключённом режиме.............................27
PSKaprs-письма................................................................................................28
Получение электронной почты......................................................................29
Вкладка заголовков почты.............................................................................29
Кнопки вкладки Mail.......................................................................................30

Вкладка Files (подключённый режим)..............................................................31
Вкладка APRS, работа в неподключённом режиме..........................................33
Режим приёма рассылок....................................................................................34
Нижняя часть клиентского окна.......................................................................34

Статусная строка, режим мониторинга........................................................34
Статусные индикаторы...................................................................................35

2



Вкладка Modem...................................................................................................35
Вкладка Igate.......................................................................................................36
Вкладка Rig control.............................................................................................36
Основное меню....................................................................................................38

File....................................................................................................................38
Mode.................................................................................................................39
Preferences.......................................................................................................39
Mbox.................................................................................................................39
Команды Info....................................................................................................39
Identi.ca............................................................................................................40
Link...................................................................................................................41
Help...................................................................................................................41

Картографическое приложение — не переведено...........................................41
Приложение A, выбор режима...........................................................................42

Таблицы режимов для адаптивного асимметричного подключения..........42
Выбор режима APRS.......................................................................................43
Управление шумоподавлением......................................................................43

Приложение B, протокол ARQ в PSKMail — не переведено............................43

3



Введение

Краткое описание истории проекта

Проекту PSKmail положил начало Рейн Куперус PA0R в начале 2005го года.
Детские шаги были пройдены с разновидностью gMFSK, был выбран режим
PSK63,  поток  сообщений  обрабатывался  единственным  существовавшим
сервером (PI4TUE). Скоро к работе присоединился другой сервер, SM0RWO в
Стокгольме, проект стал многопользовательским (с двумя пользователями) и
развивался.  На  тот  момент  был  только  один  сервер  в  Стокгольме  и  два
клиента  (PA0R  и  SM0RWO),  и  проект  приспосабливался  под  КВ.  Скоро
серверов  стало  больше,  IS0GRB/Roberto  добавил  весьма  нужный  сервер  на
Средиземноморье, присоединились WB5CON/Fred и DL9YCS/Jörg. Добавилась
группа яхтсменов-радиолюбителей Intermar из нескольких серверов. В начале
передавалась  только  электронная  почта,  и,  как  упомянуто  выше,  только  в
PSK63.  Скоро  добавилось  больше  возможностей,  в  их  числе  просмотр
интернет-страниц. Одним из важных дополнений стало APRS.
Сообщения хорошо передавались в режиме PSK63, но искренне ваш SM0RWO
чувствовал потребность в скорости и заметил, что Fldigi предлагает PSK125.
Fldigi была быстро интегрирована в программу и PSK125 долгое время был
фаворитом.  Тяга  к  быстрым  режимам  привела  к  PSK250,  замечательному
режиму, более быстрому и использующему более широкую полосу (около 250
гц). Погодите-ка, мы же почти всегда используем в наших трансиверах фильтр
на 500 Гц. Почему бы тогда не ориентироваться на режим с полосой 500 Гц? И
приблизительно летом 2009го года мы перешли на PSK500.
Длительные дискуссии в группе разработки привели к соглашению, что пора
сбросить оковы старого концепта PSK31 "от клавиатуры к клавиатуре". PSK31
был на самом деле отличной идеей,  но ему пришлось пойти на некоторые
жертвы,  чтобы  успешно  соперничать  с  радиотелетайпом  RTTY.  Время
обработки не могло быть долгим, приходилось передавать данные таким же
образом, как это делали операторы радиотелетайпа, и очевидной проблемой
было отсутствие коррекции ошибок. Отсутствующие там и тут символы легко
компенсировались при обработке человеческим сознанием, но не в случае с
компьютером с проверкой контрольной суммы или передаваемых пакетов.
John Douyere VK2ETA поставил себе задачу создать более устойчивый режим,
добавляющий  в  PSK  коррекцию  ошибок  и  перемежитель,  новый  режим
получил имя PSKRobust 500/250/125 и стал настоящим успехом. Фактически
PSKRobust 500 стал в программе режимом по умолчанию.
Рейн добавил больше вариантов, чтобы сервер имел возможность управлять
скоростью и  выбирать  режим.  Сервер  мог  переключать  текущий обмен  на
более  быстрый  режим,  когда  условия  благоприятствовали,  и,  конечно,
выбирать более устойчивый режим в ненадёжных условиях.
Добавляется и асимметричное подключение, которое не использует в обоих
направлениях  один  и  тот  же  режим  и  скорость.  Например,  это  делает
возможным  использование  со  стороны  немощного  клиента  медленного  и
устойчивого  режима,  в  то  время  как  сервер  использует  быстрый  режим.
Диапазон  режимов  ныне  простирается  от  THOR4  до  PSK500,  с
задействованием  режимов  PSK,  MFSK  и  THOR  для  адаптации  к  разным
условиям,  включая  полярные  сияния,  многолучевое  распространение  волн,
допплеровское смещение и QRN.

* В версии 2.0.х отказались от внешнего модема. Джон и Рейн переписали
модемы на Java и интегрировали их в приложение, что значительно облегчило
конфигурирование.
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Что такое PSKmail?

PSKmail  -  это  система,  использующая  режимы  передачи  данных,  чтобы
обеспечить  клиентам  доступ  в  интернет  и  взаимодействовать  с  другими
клиентами  PSKmail.  Передача  данных  используется  посредством
радиостанций,  в  большинстве  случаев  коротковолновых,  но  применяются  и
более высокие частоты.
Одна только фраза "доступ к интернету" уже означает, что система должна
поддерживать широкий спектр возможностей, и это действительно так:
1. Обмен сообщениями
- обработка электронной почты пользователей
- для аварийных ситуаций существует возможность обработки сообщений вне
интернета (интернет может отключиться, сообщения доходят всё равно)
2. Просмотр страниц интернета, получение и прочтение любой страницы
3. Твиттер, отправка и чтение записей
4. Отправка и загрузка файлов
5.  Поддержка  APRS,  включая  маркеры  местоположения,  сообщения  и
короткие электронные письма
6. Поддержка клиентов просмотра карт, таких, как Xastir и Uiview
Это  только  часть  нынешних  возможностей.  Серверы  могут  собирать
сообщения  о  погоде,  показывать,  где  находится  ближайшая  площадка  для
бивака, сообщать, какие пользователи находятся рядом, и так далее.

Каковы особенности PSKmail?

PSKmail  создана  в  расчёте  на  радиолюбителя,  работающего  в  мобильном
варианте,  из  полевых  условий  (включая  морские).  Здесь  нет  большого,
прожорливого до питания и дорогостоящего модема,  который пришлось бы
таскать  с  собой.  PSKmail  использует  как  модем звуковую карточку  вашего
компьютера,  в  настоящее  время  (в  2013м  году  появилась  самостоятельная
клиентская часть без привязки к Fldigi - примечание переводчика) для этой
цели используется программа-модем Fldigi.
Мобильная/портативная станция - обычно не то, что можно назвать "могучей",
её антенны и мощность излучения довольно скромны. Учитывая это, PSKmail
использует узкополосные режимы, с полосой едва ли шире 500 Гц (для более
высоких частот, разумеется, расклад другой).
Широкополосные  режимы передачи  данных  требуют  лучшего  соотношения
сигнал/шум, чем узкополосные, и PSKmail способна подстраивать скорость и
режим,  чтобы  клиент  мог  выбрать  действительно  узкополосный  и
эффективный  режим.  Когда  же  соотношение  сигнал/шум  улучшается  или
помехи  исчезают,  PSKmail  переключается  на  более  широкополосные  и
быстрые режимы.
Сеть PSKmail обладает гибкой топологией:
1.  Клиенты  могут  связываться  друг  с  другом,  используя  автоматический
запрос повтора, для переписки-чата или передачи сообщений
2. Клиенты могут связываться с серверами, служащими шлюзами в интернет
3.  Клиенты  могут  отправлять  друг  другу  сообщения  в  "неподключенном"
режиме
4. Клиенты могут отправлять сообщения APRS и маркеры местоположения в
инфраструктуру APRS посредством серверов
5. Клиенты также содержат личный Igate, способный передавать сообщения и
маркеры местоположения в APRS
6. Клиенты содержат функционал протокола telnet, посредством которого вы
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можете связываться с приложениями Xastir и Uiview
i - Система также позволяет соединяться по протоколу telnet со службами в
интернет или в сети, подключённой к серверу.

В целом, что же такое PSKmail?

Основные характеристики PSKmail могут быть обобщены как:
- полудуплексный чат c автоматическим запросом повтора, поддерживающий
передачу файлов
- полноценное решение для APRS на КВ, включающее интеграцию с картами
- подключение к интернету там, где нет интернет-подключения. На лодке в
море, или в избушке в экспедиции, или...
-  узкополосные,  эффективные  режимы  передачи  данных,  допускающие
использование даже самого скромного оборудования
-  серверы  на  коротких  волнах,  обеспечивающие  подключение  на  больших
расстояниях
-  отсутствие  дорогого  неуклюжего  модема,  всё,  что  нужно  -  компьютер,
трансивер и антенна
-  доступность  на  ряде  операционных  систем  (Linux  и  Windows,  MacOS  и
FreeBSD)

Что насчёт безопасности в PSKmail?

Начиная с версии jPSKmail-1.2, соединение защищено паролем. Если пароль
не  установлен,  подключение  небезопасно.  Чтобы  использовать  получение
почты по протоколу POP3, сервер должен знать, где забирать вашу почту.
В противоположность другим почтовым системам на КВ, сервер PSKmail не
хранит вашу почту, он переправляет её из вашего почтового ящика. Сервер
хранит ваши данные протокола POP в базе данных - сервер, имя пользователя
и  пароль.  База  данных  может  обновляться  со  стороны клиента,  отправкой
записи на сервер с командой обновления. Чтобы быть уверенным, что только
сервер  получит  эту  информацию,  клиент  отправляет  эту  запись,  используя
"куки".  Устанавливая  пароль  соединения  в  меню  настроек,  вы  можете
обезопасить себя, чтобы кто-то, использующий ваш позывной, не мог получить
вашу почту. Вам нужно делать это только один раз для каждого сервера (если
только база данных не будет утрачена).  В версиях клиента jPSKmail-1.5.6 и
сервера 1.5.1 вы можете удалить эту запись с сервера.
Данные (почта, файлы, веб-страницы) НЕ шифруются при соединении,
но их возможно посылать архивированными, чтобы ускорить передачу.
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Установка и начало работы

Для использования PSKmail вам нужны:

1. Радиолюбительская лицензия

2. Коротковолновый трансивер с работающей антенной системой, это может
включать антенное согласующее устройство

3. Компьютер, работающий под управлением ОС Linux, MacOS или Windows.
- FreeBSD также годится, но нам не хватает отзывов тестеров по ней.

4. Интерфейс для соединения звуковой карточки компьютера с трансивером.

5. Настоятельно рекомендуется узкополосный фильтр (500 Гц) в трансивере.
Полосовой сигнальный процессор - тоже неплохо, но настоящего фильтра он
не заменит.

Для установки и использования клиента jPSKmail вам потребуется:

1. Исполняющая система Java
-  для Linux  и  MacOS нужно обратиться к  сервису  установки программного
обеспечения (репозиторию и т.п.)
- в иных случаях, сюда: http://java.com/en/download/manual.jsp 

2. Соответствующий модем, мы используем Fldigi
-  Fldigi  можно  отыскать  здесь:  http://www.w1hkj.com/Fldigi.html (в  Ubuntu-
подобных системах доступны репозитории - примечание переводчика)

Последовательность установки

Установка в общем сходная для всех операционных систем, есть небольшие
различия и они будут рассмотрены позже. Шаги следующие:
1. Загрузить и установить Fldigi
2. Установить jPSKmail
3. Убедиться, что установлена исполняющая система Java
4. Запустить актуальные установленные программы
5. Настроить Fldigi и клиент jPSKmail

Необязательный картографический клиент APRS

APRS содержит гегорафическую информацию, такую, как положение судов,
транспортных средств и т.д. Очень удобно видеть эти данные поверх карты,
вот почему картографический клиент APRS может подключаться к jPSKmail и
использовать его как локальный интернет-сервер. JPSKmail передаёт данные
APRS такому  клиенту.  Для  подключения картографического  приложения к
PSKmail используйте tcp порт номер 8063.
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Инструкции по установке RXTX

JPSKmail  требует  JAVA  Communication  API  для  подключения  к  GPS  по
последовательному  порту  (RS232  или  USB),  это  и  есть  библиотека  rxtx.
Нижеследующие шаги обязательны только если вы планируете использовать
GPS.

Windows 98/NT/2000/XP:
Необходимые для установки rxtx файлы вы найдёте внутри каталога, куда вы
установили jPSKmail.
Последовательность действий:
- копируйте файл rxtxSerial.dll в каталог %JAVA_HOME%\bin, (где %JAVA_HOME
%  является  именем  каталога,  в  который  в  вашей  системе  установлена
исполняющая система Java; например c:\Program Files\Java\j2re1.4.1_01 )
- копируйте файл RXTXcomm.jar в каталог %JAVA_HOME%\lib\ext

Linux:
Если  вы  используете  Ubuntu,  то  весьма  легко  установите  "librxtx-java"  [из
репозитория]  с  помощью менеджера пакетов  или через  командную строку,
выполнив "sudo apt-get install librxtx-java".

Иначе, действия вручную:
Для  других  систем  Linux,  отличных  от  Ubuntu,  требуется  нижеследующая
последовательность действий по копированию файлов  из каталога,  куда вы
установили jPSKmail.
-  копируйте  файл  librxtxSerial.so  в  каталог  %JAVA_HOME%/jre/lib/i386,  (где
%JAVA_HOME%  является  именем  каталога,  в  который  в  вашей  системе
установлена исполняющая система Java; например /usr/local/j2sdk1.4.1_01)
- копируйте файл RXTXcomm.jar в каталог %JAVA_HOME%/jre/lib/ext
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Выбор оборудования — не переведено

Трансивер

( предпочтителен фильтр 500 Гц )

Интерфейс к звуковой карточке

( предпочтителен интерфейс, задействующий PTT, а не использующий VOX)

Антенна

(  большие  антенны  —  это  хорошие  антенны,  маленькие  антенны  -  только
маленькие антенны )

Принадлежащий SM0RWO комплект оборудования для работы в полевых
условиях, слева направо: FT-817ND, SB-2000, EEE-PC.
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Настройка Fldigi

PSKmail для работы нужен модем, этим модемом является Fldigi и поэтому её
правильная настройка критически важна. Общие настройки Fldigi прекрасно
описаны в руководстве к этой программе. Но к некоторым моментам следует
проявить особое внимание при работе с PSKmail.
Нужные  настройки  доступны  в  меню  Configure  ->  Modems,  вкладка  с
настройками почты находится в меню Configure -> Misc -> Pskmail.

Carrier frequency (Hz) - Частота несущей (Гц)
Частота несущей - это звуковая частота, которую вы намерены использовать
на  своей  радиостанции.  Многие  используют  здесь  1000  Гц,  поскольку  это
упрощает  расчёты.  Например,  если  сервер  использует  назначенную  ему
частоту 10147, а вы ввели 1000 Гц, тогда на экране будет отображено 10146
(при использовании верхней боковой полосы). Важно, чтобы частота несущей
приходилась на середину полосы вашего узкополосного фильтра. Например,
если в вашем IC756 середина полосы фильтра ЦОС приходится на 1500 Гц,
устанавливайте частоту несущей на 1500.

AFC range (Hz) - Автоподстройка частоты (Гц)
Хорошо, если сервер и клиент находятся на одной и той же частоте, модемы
будут стараться не потерять друг друга, автоматически подстраивая частоту.
Вот  зачем  нам  нужно  устанавливать  пределы,  в  которых  автоподстройка
частоты сможет изменить рабочую частоту. AFC range для широкополосных
режимов составляет 50 Гц, для узкополосных вроде PSK 63 достаточно 10 Гц.

Настройка Reset to Carrier и настройка Report ARQ frames average S/N
Reset  to  Carrier  срабатывает  при  отсутствии  сигналов,  возвращая
аудиочастоту  на  установленную  частоту  несущей,  это  рекомендуется
включить. Настройка Report ARQ frames ДОЛЖНА быть включена.
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Эти настройки имеют значение только  в  случае,  если  Fldigi  подключена к
клиенту pskmail. Если Fldigi уходит с частоты и как будто игнорирует то, что
вы  ввели  здесь,  похоже,  что  связь  между  клиентом  и  модемом  утрачена.
Инициализация  происходит  только  тогда,  когда  клиент  или  сервер
подключаются  к  модему  (Fldigi).  Это  означает,  что  вы  всегда  должны
запускать Fldigi прежде, чем запускать сервер или клиент pskmail.

Убедитесь, что:
- Fldigi запущена до того, как запущен сервер или клиент;
- если Fldigi была по какой-либо причине перезапущена, то сервер или клиент
также перезапущен.

RS ID

Следующее, о чём следует позаботиться - настройка RS ID (меню Configure ->
IDs). Попросту сбросьте все галочки в окнах на этой вкладке, как показано на
иллюстрации:

Полезно отключить приём и передачу RSID для режимов, которые pskmail не
использует, чтобы гарантировать, что Fldigi не переключится в неподходящий
режим.

Также включите в Fldigi настройку XML-RPC (меню Configure -> Rig [control]
-> XML-RPC), необходимую для управления радиостанцией и передачи данных
клиенту по соотношению сигнал/шум:
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Когда Fldigi  заработает,  вы можете попробовать выполнить проверку связи
(ping)  на  одной  из  серверных  частот,  если  ваш  сигнал  будет  декодирован
сервером, то вы получите ответ.

В некоторых конфигурациях Fldigi не отправляет последний символ фрейма
<EOT>. В этом случае вы можете добавить во фрейм несколько случайных
символов во вкладке Модем в клиенте pskmail (меню Preferences). Когда вы
получаете ответ от сервера, вы добились успеха.

Вы можете попросить другую станцию в эфире оценить ваш сигнал,  чтобы
проверить, не слишком ли он широк. Включение на передачу должно лишь
немного  затрагивать  индикатор  ALC.  Теперь  вы  готовы  присоединиться  к
веселью.

Но сперва Вы, конечно же, прочитаете данное руководство до конца?
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Обзор пользовательской программы

Окно  приложения-клиента  jPSKmail  содержит  часть  постоянно  видимых
областей,  и  часть  –  расположенных  во  вкладках.  Сразу  после  запуска
отображается главное окно.

Основное окно разделено на несколько функциональных частей:

Строка меню

Кнопки доступа 
к важным функциям 
на выбранной вкладке

Область выбранной вкладки, 
содержимое зависит 
от конкретной вкладки

Выбор вкладок

Область модемного монитора, 
видима всегда

Статус приложения, исходящий текст, 
выбор сервера и пр.
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Основные вкладки и их назначение:

•  Terminal,  отображает  обмен  с  другими  станциями  (с  корректировкой
ошибок)
Это не то же самое, что модемный монитор, в котором отображается текст
текущей сессии

• Email, здесь вы можете отправлять и получать электронную почту

•  Files,  здесь  вы  можете  обмениваться  файлами  с  сервером  или  другим
клиентом

•  APRS,  контроль APRS активности -  местоположения, сообщения, маяки и
т.д.
У многих эта вкладка активна даже без подключения к серверу.

•  Modem,  отображает  сигнал/шум,  режим  и  статистику  модема,  включая
доступные серверы

• Igate, отображает данные о маяках, подключённых к интернет

• Rigctl, обеспечивает доступ к функциям сканирования и призывания

Но  прежде,  чем  мы  подробно  рассмотрим  основное  окно,  нам  следует
углубиться в конфигурирование и настройку клиента.
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Окно параметров

В  первую  очередь  нужно  установить  ваши  параметры.  Окно  параметров
доступно через меню Preferences -> Edit.

Пользовательские данные

Поля на первой вкладке (User data) нуждаются в заполнении:

1. Callsign - Позывной сигнал опознавания любительской радиостанции
Используйте в позывном заглавные буквы, и не указывайте здесь дополнений
вроде ZL/ или /M
Допустимы SSID (-2, -15)

Настройки вашей электронной почты хранятся на сервере с использованием
позывного как ключа. Если вы желаете проверять несколько учётных записей,
то вам нужно привязать каждый из них к SSID, например, никакого SSID для
основной  учётной  записи  и  -2  для  дополнительной.  Просто  впечатайте
информацию,  обновите  данные  на  сервере  и  повторите  эти  действия  для
следующей учётной записи.

2. Link to - Связываться с...
Позывной сервера или клиента, с которым вы хотите связаться, обычно тот,
который вы слышите лучше всего.

В  энциклопедии  pskmail  есть  список  серверов,  их  владельцам  высказано
пожелание  своевременно  вносить  туда  соответствующие  исправления:
http://pskmail.wikidot.com/wiki:frequencies 

Позывной сервера может быть изменён при выборе сервера в строке внизу
окна.
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3. Minute
Маячная минута, в которую клиент подаёт сигнал. У сервера есть периоды
длительностью  в  1  минуту  в  течение  периода  длительностью  5  минут.
Значение изменяется от 0 до 4. Это используется для уверенности, что вы ни с
кем не помешали друг другу.  Также, поскольку серверы могут сканировать
несколько частот, таким образом вы можете выбрать канал.

4. Latitude
Широта в десятичных долях градуса - на случай, если вы не используете GPS-
приёмник.  Вы можете оставить это поле пустым, если намерены заполнить
вкладку устройств и указать,  как подключён GPS. Северное значение здесь
положительное.

5. Longitude
Долгота в десятичных долях градуса - на случай, если вы не используете GPS-
приёмник.  Вы можете оставить это поле пустым, если намерены заполнить
вкладку устройств и указать, как подключён GPS. Восточное значение здесь
положительное.

6. Установленный для соединения пароль.

Отправка пароля соединения на сервер

Подключитесь к серверу. После отправки ваших данных почты,
напишите: SETPASSWORD <enter>

Маячная минута и канал сервера

Владелец  сервера  может  пожелать  перекрыть  несколько  частот,  используя
только один трансивер. Переключаясь между несколькими диапазона, можно
обеспечить местную связь на низких частотах и дальнюю связь на высоких
(используя  антенну,  способную  это  реализовать).  PSKMail  использует
пятиминутный  период  сканирования,  в  течение  которого  сервер  может
слушать  по  одной  частоте  в  одну  минуту.  Маячная  минута  в  настройках
клиента  определяет,  в  которую  из  этих  пяти  минут  отправлять
местоположение APRS,  правильным значением здесь является та минута,  в
которую  интересующий  вас  сервер  слушает  частоту,  на  которую  вы
настроены. Период сканирования повторяется снова и снова,  пятая минута
часа становится минутой номер 0 в периоде, и так далее.

Допустим, сервер сканирует частоты на диапазонах 80, 40, 30, 20 и 17 метров.
Он слушает в течение минуты каждую частоту, и поскольку в энциклопедии
pskmail  есть  списки  частот  всех  серверов,  вы  можете  выяснить,  на  какой
частоте и в каком режиме сервер активен в каждую из минут периода. Таким
образом, если вы хотите попробовать связаться с сервером на диапазоне 30
метров, вы видите, что сервер на этом диапазоне находится в течение минуты
2. Значит, вы устанавливаете в настройках клиента минуту 2 и таким образом
подача сигнала и всё остальное происходит в правильный период времени.

Это  означает,  что  важно  синхронизировать  время  на  вашем  компьютере,
используя NTP либо вручную. Есть ряд способов это сделать, от использования
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сигналов  GPS  (время  GPS  видно  рядом  с  маркером  местоположения  во
вкладке APRS, если вы подключены к GPS). На данный момент (- примечание)
jPSKmail  не  обновляет  системное  время,  это  связано  с  тем,  что  в  разных
системах это требует различных прав пользователя.

В ходе сессии подключения, пока функция мониторинга активна, а также в
ходе приёма рассылки, сканирование останавливается и клиент остаётся на
канале.

Выбор подходящих режимов

Условия приёма  могут  быть  совершенно разными на стороне  сервера и  на
стороне клиента. Часто сервер работает большей мощностью, чем клиент, и
антенна  клиента  часто  слишком  мала,  неточно  настроена  и  окружена
источниками  помех.  Последнее  -  обычное  дело  в  местах  биваков  со
множеством электроприборов, или в гавани среди лодок. Вот почему PSKmail
способна  использовать  асимметричное  подключение,  задействующее
разные  режимы  для  аплинка  (передачи  сигнала  от  клиента  к  серверу)  и
даунлинка  (передачи  сигнала  от  сервера  к  клиенту).  Управление
подключением  осуществляется  сервером.  Смена  режима  происходит  с
помощью  RSID,  отдельного  очень  надёжного  MFSK-сигнала,  сообщающего
модему  на  другой  стороне,  в  каком  режиме  ему  следует  слушать.  Верный
приём  RSID  сигнала  критически  важен  для  успешной  работы  с  функцией
автоматического запроса повтора, и это является нижним пределом того, что
может быть осуществлено при подключении. Важно верно выбирать режимы,
способные обеспечить связь с другой стороной. Хороший выбор режима для
клиента  -  режим,  в  котором  сервер  слушает  по  умолчанию  (PSK500R  или
PSK250),  THOR22,  или  MFSK16.  После  установки  подключения  сервер
управляет  выбором  режима  и  использует  нужные  режимы  для  аплинка  и
даунлинка.  Если  вы  не  уверены  в  точности  частоты,  можете  попробовать
THOR22,  который  малочувствителен  к  небольшим  сдвигам  по  частоте.
Появившееся  в  версии  1.5.6  окно  подключения  позволяет  устанавливать
различные режимы на приём и передачу.

Пожалуйста, учитывайте, что медленные режимы требуют большего
времени на подключение к серверу. Расплатой служит необходимость
начинать  подключение  в  начале  минуты.  Недавно  представленный
THOR4  требует  даже  90  секунд,  поэтому  может  быть  использован
только в случае, если сервер слушает в THOR4 минимум две минуты!

Установка таблицы режимов и режима по умолчанию

Начиная  с  версии  1.4.0,  клиент  может  установить  по  своему  усмотрению
таблицу режимов, которая отсылается на сервер при первичном подключении.
Таблица режимов настраивается в меню Preferences -> Edit -> Modes:
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Щелчком  на  кнопке  Fix  list вы  закрепляете  таблицу  режимов,  затем
выбираете режим по умолчанию в выпадающем меню Def.mode и нажимаете
OK, чтобы сохранить изменения.

Установка режимов работы

Появившееся в версии 1.5.6 окно подключения позволяет выбирать, к какому
серверу подключаться, и какие режимы использовать на передачу и на приём
в ходе первичного подключения.

После  того,  как  подключение  установлено,  выбором  режима  управляет
сервер.

Во время простоя и не в процессе мониторинга клиент автоматически
переключается обратно на режим по умолчанию.
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Настройки электронной почты

Edit->Preferences->Mail

1. Pop host
Имя вашего  сервера,  работающего  по протоколу  POP,  если вы используете
учётную запись Gmail, то пишите здесь pop.gmail.com.

2. Pop user
Ваше имя пользователя по протоколу POP. Для Gmail это полное имя учётной
записи (включающее @gmail.com или @your_domain.com).

3. Pop password
Ваш пароль к учётной записи, доступной по протоколу POP.

4. Return address
Когда кто-то захочет ответить вам на ваше электронное письмо, ответ будет
прислан на обратный адрес; если вы хотите получить ответ, будучи в отлучке,
испльзуйте адрес почты, которую вы сможете проверить. При отправке почты
сервер протокола SMTP проверяет, рабочий ли указан обратный адрес.  Это
также  важно  при  отправке  однострочных  писем  по  APRS.  Сервер,  не
располагающий вашим обратным адресом, может быть неспособен передать
вашу  почту.  Для  Gmail  это  полное  имя  учётной  записи  (включающее
@gmail.com или @your_domain.com).

Теперь также возможно указывать в каждом письме другой обратный адрес,
что удобно, если вас несколько человек на одной лодке.

5. Compressed OTA
Сжатие  при  передаче  в  эфире  -  включите  эту  настройку,  чтобы  сжимать
письма  и  страницы  при  передаче  в  эфире.  Сжатие  означает,  что  данные
передаются  как  бинарные  архивные  файлы,  что  может  ускорить  передачу
вдвое.

Вкладка Configuration

Preferences -> Edit -> Configuration

1. Log file

2. Max retries
Максимальное количество попыток в режиме TTY (переписки-чата)

3. Idle time
Максимальное  время  (в  секундах),  которое  клиент  ожидает  прежде,  чем
завершить сессию при простое (только в режиме переписки-чата)

4. TX delay
Задержка в секундах прежде, чем начинается передача. Обычно равна нулю.

19



5. Beacon second
Вы можете точно указать время, когда ваша станция подаёт сигнал маяка,
изменяя это значение

6. Offset minute
Устарело и отключено

7. DCD hang time
Настройка DCD hang time устанавливает чувствительность к шуму в приёмном
канале. Значение 1...2 подходит в большинстве случаев. Значение 0 отключает
эту функцию. Если значение слишком велико, задержка может мешать подаче
сигнала  маяка.  Если  в  канале  слишком  много  шума  (принимаются
неразборчивые  символы),  клиент  может  оказаться  неспособным  послать
статусное  сообщение  вовремя.  В  ходе  подключения  данная  функция
неактивна.

Вкладка Devices

Preferences -> Edit -> Devices
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Эта  вкладка  посвящена  внешним устройствам и  подключениям.  На  данное
время это означает внешний приёмник GPS и внутренний сервер APRS для
внешних  картографических  клиентов.  GPS  используется  для  маркера
местоположения, а также получения точного времени по GPS с последующим
отображением.  Внутренний  сервер  APRS  используется  картографическим
клиентом.  Данные  APRS  передаются  в  картографический  клиент,  чтобы
географические данные могли отображаться на карте.

1. GPS is connected
Если  библиотека  rxtx  установлена,  это  окошко  может  быть  использовано.
Отметьте его, чтобы клиент искал, и использовал, приёмник GPS.

2. Use gpsd
Gpsd  -  сервер  GPS-данных,  написанный  для  ОС  Linux.  Он  позволяет
программам  использовать  данные  с  GPS-приёмника.  Уберите  эту  галочку,
если используете Windows. jPSKmail использует новый протокол gpsd, поэтому
должна использоваться версия gpsd свежее 2.9.0.

3. Serial port
Куда  подключён  GPS-приёмник?  Клиент  попытается  получить  данные  с
последовательных портов системы.

4. Speed
Стандартная  скорость  NMEA  обычно  составляет  4800  б/сек,  но,  если
используются другие скорости, выберите здесь соответствующую.

5. APRS Server port enabled
jPSKmail  может  выступать  как  ваш  собственный  интернет-сервер  APRS.
Просто укажите картографическому клиенту локальный хост, когда jPSKmail и
картографический клиент установлены на одном и том же компьютере.

6. Port number
Номер порта, по которому клиент APRS подключён к локальному хосту.

Вкладка Modem

Preferences -> Edit -> Modem
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Эта  вкладка  контролирует  подключение  клиента  к  модему  (Fldigi).  В
большинстве случаев они сосуществуют на одном и том же компьютере, но
отлично работают и на разных компьютерах в локальной сети.

1. IP Address
Адрес модема,  на одном и том же компьютере можно ввести localhost  или
127.0.0.1, в локальной сети или интернете укажите нужный IP-адрес. Если вы
захотите  запускать  Fldigi  на  одном  компьютере  (например,  в  вашей
радиорубке),  а  jPSKmail  на  другом  (скажем,  во  садочке),  обратитесь  к
нижеследующему разделу руководства, где это описано.

2. IP Port
Это  номер  порта,  который  использует  модем  (Fldigi)  и  к  которому  клиент
будет подключаться. Стандартным на данный момент является 7322.

3. Frame preamble
Некоторые  радиостанции  сообщали  о  проблемах  с  передачей  неполного
фрейма.  Если  отсутствует  начало  фрейма,  то  есть  возможность  добавить
несколько  дополнительных  символов,  которые  будут  переданы  до  начала
фрейма. В большинстве случаев это поле пустует.

4. Frame postamble
Работает как и предыдущий пункт, только после фрейма.

Запуск fldigi и jPSKmail на раздельных компьютерах

Вы не можете находиться всё время у себя в  радиорубке.  Можно захотеть
использовать jpskmail из беседки в саду, не перемещая трансивер и антенны.
К  счастью,  jpskmail  позволяет  подключиться  к  Fldigi  удалённо.  Чтобы  это
сделать, нужны следующие действия:

1. Запустить fldigi с соответствующими параметрами командной строки:
--arq-server-address HOSTNAME (По умолчанию: 127.0.0.1 )
--arq-server-port PORT (По умолчанию: 7322)
--xmlrpc-server-address HOSTNAME (По умолчанию: 127.0.0.1 )
--xmlrpc-server-port PORT (По умолчанию: 7362)

2. Выбрать в меню jpskmail edit->preferences->modem и ввести имя хоста

3. Нажать кнопку OK

4. Перезапустить jpskmail

Теперь jpskmail подключится к fldigi удалённо. Достаточно запускать на eeePC
701.
Когда fldigi свёрнута, ноутбук потребляет всего несколько Ватт, выполняя при
этом также и функцию файл-сервера.
Таким образом, можно работать в jpskmail где угодно на территории жилища,
оставаясь в пределах досягаемости точки доступа wi-fi.
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Вкладки основного окна

Вкладка Terminal, работа в подключённом состоянии

Во вкладке Terminal вы можете подключиться к серверу.

1.  Нажмите  кнопку  Connect или  выберите  в  меню  Files->Connections-
>Connect
Отобразится диалоговое окно, где вы сможете выбрать режимы.

2.  Ожидайте от  сервера  подтверждения  и  начала  подключения.  Статус
сменится  с  "Listening"  на  "SERVERCALL",  и  маленький  цветной  индикатор
внизу станет зелёным. PSKmail использует подтверждение подключения, и вы
знаете наверняка,  что подключение успешно,  когда видите приветственное
сообщение от сервера.

3. Теперь вы можете передавать серверу любые команды, которые он сможет
понять. Наиболее важные функции доступны нажатием кнопок или выбором
пунктов меню.
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4. Чтобы завершить подключение, нажмите кнопку QUIT.

5. Если сервер не получил этой команды, вы можете разорвать подключение
нажатием  кнопки  Abort.  Однако  более  вежливо  будет  подождать
разъединения по команде  QUIT, в этом случае сервер не посылает запросы
вплоть до тайм-аута.

Нажатием кнопки Abort вы производите односторонний разрыв соединения.
Клиент отправляет на сервер фрейм отмены. Если сервер его не получит, он
продолжит отправлять запросы, пока не произойдёт тайм-аут. Это считается
не слишком вежливым.

С  помощью  кнопки  Pos.  вы  можете  вручную  отправить  маркер
местоположения APRS. Сервер, получивший его, пришлёт QSL-пакет. Вам не
нужно проводить подключение для этого.

Вкладка Terminal, режим переписки-чата

Чтобы  использовать  режим  переписки  (от  клиента  к  клиенту),  введите
позывной станции,  которую вы хотите вызвать,  в  окошко выбора сервера и
нажмите  кнопку  Connect.  Начиная  с  версии  jPSKmail  0.8.5,  используется
автоматический выбор режима.
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Для отправки файла перейдите на вкладку Files и нажмите кнопку Upload.
После выбора файла для отправки клиент спросит у вас, какому адресату вы
отправляете файл. jPSKmail готовится к поддержке Delay Tolerant Networking в
будущем.

Создание сообщения электронной почты

Есть два способа создать и передать электронное письмо с помощью jPSKmail:
-  настоящие  электронные  письма,  с  темой  по  выбору,  с  возможностью
прикрепить файл;
-  очень  короткие  электронные  письма,  называющиеся  pskaprs-письмами,  с
жёстко заданной темой и без вложений.
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Подготовка сообщения электронной почты

Редактор  электронных  писем  доступен  по  кнопке  New  во  вкладке  Email.
Редактор  достаточно  прост,  в  нём  есть  поля  для  адреса,  копии,  темы  и
содержимого письма.

• To
Введите  здесь  адрес  получателя.  Адреса  многочисленных  корреспондентов
разделяйте запятой: “user1@domain.com, user2@domain.com”
Щелчок по кнопке To откроет окно с  адресной книгой,  попросту  выберите
желаемые контакты и нажмите Add в поля To или Copy. Затем нажмите Close,
и адресаты будут показаны в соответствующих полях.

• Copy
Пожалуйста, примите во внимание, что этот функционал пока не реализован
на сервере. В настоящее время он просто добавляет адресатов вашего письма,
подобно тому, как делают другие клиенты электронной почты.
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• Subject
Это тема письма, и желательно формулировать её кратко

• Message body
Содержимое письма, собственно его содержание

• Add attachment
Если  вы  хотите  добавить  вложение,  отыщите  его  после  щелчка  по  этой
кнопке. Прикреплённый файл будет сжат и упакован в сообщение, поэтому
учитывайте, что он должен быть небольшим.
Желательно добавлять вложения не более нескольких килобайт.

Отправка электронной почты в подключённом режиме

При подключении кнопка Send во вкладке Email может быть использована для
передачи подготовленных вами сообщений в локальной папке исходящих. В
настоящее время кнопка Send отправляет письма по одному, поэтому, если вы
отправляете два письма, вам нужно нажать эту кнопку первый раз, убедиться,
что  первое  письмо  принято  сервером  (и  удалено  из  исходящих),  и  затем
повторить эти действия.

Если  вы  хотите  отправить  определённое  сообщение  из  папки  исходящих  в
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первую очередь,  например, отправляя сообщение, адресованное локальному
пользователю на сервере, с которым вы в данный момент соединены, отметьте
это сообщение в исходящих прежде, чем нажать на кнопку отправки. Таким
образом  отмеченное  сообщение  будет  отправлено  первым,  минуя  очередь
отправки.  В настоящее время эта  процедура работает только при отправке
сжатой электронной почты.

Выбор определённого письма для отправки в первую очередь.

PSKaprs-письма

Этим  способом  отправляются  короткие  текстовые  сообщения  с  жёстко
заданной  темой  на  один  адрес  электронной  почты.  Это  осуществляется  в
неподключённом режиме и сервер, который примет это сообщение, пришлёт
пакет подтверждения.

Поскольку сообщение отправляется без подключения, то его краткость весьма
способствует его доставке на сервер.
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Получение электронной почты

Полученная  почта  помещается  в  файл  Inbox,  входящие.  Этот  файл  имеет
формат mbox, и вы можете использовать его как spool-файл в таких почтовых
клиентах,  как  Sylpheed  или  Thunderbird.  Так  почта,  которую вы получаете
через PSKmail, будет объединена с вашей обычной почтой.

Чтобы прочесть вашу почту через jPSKmail:
• подключитесь к серверу
• перейдите во вкладку Email
• нажмите кнопку QTC, заголовки будут добавлены в список
• когда вы захотите загрузить почту,  дважды щёлкните на заголовке, он
будет  добавлен  во  входящие.  Щелчок  правой  кнопкой  мыши  на  заголовке
вызовет короткое меню (загрузить или открыть).
• когда вы захотите прочесть почту, зайдите во вкладку входящих и дважды
щёлкните на заголовке. Опять же, щелчок ПКМ вызовет краткое меню.

Входящее письмо с вложением (внизу окна). Щёлкните на кнопке Save, чтобы
сохранить прикреплённый файл у себя.

Вкладка заголовков почты

Эта  вкладка  отображает  список  сообщений,  полученный от  вашей учётной
записи электронной почты при подключении к серверу PSKMail. Вы можете
выбрать почту для загрузки щелчком ПКМ на заголовке. Одно письмо за раз.
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Кнопки вкладки Mail

Кнопка  New  открывает  диалог  создания  нового  письма.  Есть  возможность
добавить небольшое вложение (около 6 килобайт).

Кнопка QTC запрашивает заголовки новой почты из вашей учётной записи
электронной почты. Сперва прочитывается файл заголовков, чтобы выяснить,
какой из заголовков был загружен последним. Запрашиваются только новые
заголовки.
Вы можете изменить эту процедуру, как очистив файл заголовков (File->Clear-
>headers), так и отправив серверу '~QTC +0'.

Загрузка почты осуществляется щелчком ПКМ на заголовке.

Когда загрузка начинается, полоса прогресса отображает ход процесса:

Полоса прогресса  возвращается к  нулю после того,  как достигнет 100%.  В
режиме  мониторинга  или  прослушивания  эта  полоса  отображает  качество
сигнала.
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Кнопка Send запускает отправку первого письма во вкладке исходящих. Когда
от сервера приходит подтверждение, письмо удаляется из папки исходящий.
Оно доступно в файле 'Sent', отправленные.

С помощью кнопки Delete вы можете удалять письма из почтового ящика на
почтовом сервисе в интернет. Введите номера удаляемых писем в поле ввода.
Вы можете ввести более 1 номера, разделив их пробелами. В случае успеха
сервер ответит "Mails x x deleted..."

Номера отражают нумерацию в вашем ящике на почтовом сервисе.
После  удаления  почты  вам  следует  очистить  список  заголовков  и
обновить  его,  чтобы список  соответствовал  нумерации в  ящике  на
сервисе.

Вкладка Files (подключённый режим)

Чтобы скачать файл с сервера, введите имя файла в поле ввода, или дважды
щёлкните  на  имени  файла  в  списке  файлов,  затем  нажмите  кнопку
скачивания.
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Файлы скачиваются в бинарном виде, сжатые gzip в кодировке base64. Клиент
декодирует и разархивирует их и помещает в каталог Downloads.

После  скачивания  файл  может  быть  ПРОЧИТАН,  либо  ОБНОВЛЁН.
Диалоговое окно сделает это нетрудным.
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Вкладка APRS, работа в неподключённом режиме

Работа  в  неподключённом состоянии (как  UI  frames  в  пакетном  радио)
проводится в окне APRS.

В  этом  окне  вы  можете  изучать  маркеры  местоположения,  отправлять
сообщения APRS другим станциям PSKMail,  УКВ-станциям,  или в  интернет
(Uiview,  Xastir),  или  отправлять  короткие  письма  APRS  на  любой  адрес
электронной почты.
Вы  осуществляете  это  с  помощью  сервера  PSKMail,  служащего  шлюзом  в
интернет.  Серверы  взаимосвязаны  через  интернет-инфраструктуру  APRS
(APRS-IS).

Вы можете  указать  сервер,  который хотите  использовать,  в выпадающем
списке серверов, внизу окна.
При  запуске  программы сервер  загружается  из  конфигурационного  файла.
Ваш клиент PSKMail автоматически добавляет серверы в список по мере того,
как принимает данные маяков и сообщения.

Обладать  возможностью  принимать  сообщения  от  сервера
необходимо, чтобы оказаться в его таблице подключений. Эта таблица
гарантирует, что сообщения отправляются только одним сервером в момент
времени.  Чтобы  добавиться  в  таблицу  подключений,  вы  можете  вручную
отослать  на  сервер  запрос  на  подключение (ctrl-l).  Сервер  подтвердит
запрос и поместит ваш позывной в его таблицу подключений. Это может быть
сделано  и  автоматически.  Клиент  проверяет,  соответствует  ли  последнее
подключение  предпочитаемому  серверу,  и  отсылает  новый  запрос  при
необходимости.  Автоматическое  добавление  может  быть  отключено  во
вкладке APRS.
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Во вкладке APRS вы можете установить иконку APRS-маяка, маячный период
и статусное сообщение. Маячная минута (0...4) может быть установлена внизу
окна, маячная секунда в меню Preferences->Edit->configuration.
Распространённой  практикой  является  установка  маячного  периода  в  30
минут или 60 минут для неподвижных объектов.

Чтобы отправить маркер местоположения вручную, вы можете нажать ctrl-
b или кнопку Pos. во вкладке Terminal.

Чтобы отправить  текстовое  сообщение APRS,  попросту  введите  “CALLSIGN
Texttexttext”  в  поле  текстового  ввода  внизу  окна.  Используйте  заглавные
буквы  в  позывном.  Если  позывной  опознан  УКВ-дигипитером,  он  будет
отправлен по УКВ.
Чтобы отправить короткое электронное письмо,  введите “email@addres.xxx
Texttexttext” в поле текстовго ввода.

Режим приёма рассылок

Когда  бы  клиент  ни  принимал  рассылку  (всё,  начинающееся  с  'ZCZC'  и
заканчивающееся  'NNNN'),  он  входит  в  режим  приёма  рассылок.  В  этом
режиме:
• Сканирование частот останавливается в ходе приёма рассылки
• Принятый текст помещается в файл ~/.pskmail/Downloads/bulletins.

Нижняя часть клиентского окна

Статусная строка, режим мониторинга

Статусная строка отображает, чем занят клиент, большую часть времени это
"прослушивание".
Когда вы щёлкаете по статусной строке, происходит переключение в режим
мониторинга.  В  этом  режиме  входящие  пакеты  отображаются  с  меткой
времени, а также партнёры по подключению, если доступны.
Режим  мониторинга  автоматически  прекращается,  когда  устанавливается
подключение, или когда принимается рассылка. Также режим мониторинга
останавливает сканирование частот, чтобы вы могли эффективно следить за
одним каналом.
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Статусные индикаторы

Статусных индикаторов два,  канальный и подключения.  Левый индикатор -
канальный. Цвета означают:
• Серый - простой, данных нет
• Жёлтый - есть данные, not valid
• Синий - блок данных в обработке
• Красный - данные передаются

Правый индикатор отображает статус подключения. Цвета означают:
• Зелёный - ошибок при подключении нет
• Жёлтый - ошибки приёма
• Синий - ошибки передачи
• Красный - ошибки приёма и передачи
Присутствует  небольшая  задержка,  поскольку  клиент  не  знает  статуса
подключения до тех пор, пока не получит его от сервера, то есть большую
часть времени индикатор подключения опаздывает на один фрейм.

Вкладка Modem

Эта вкладка отображает некоторые интересные вещи относительно текущего
статуса  модема.  Например,  она  показывает  режимы  приёма  и  передачи,
которые  могут  различаться  в  течение  подключения  в  силу  возможности
асимметричного  подключения.  Соотношение  сигнал/шум  сообщается  без
промедления  и  используется  для  сортировки  услышанных  серверов.
Показатель Rx CPM означает скрость приёма (Characters Per Minute).
Максимальная  возможная  скорость  измерена  как  1862  знаков  в  минуту
(PSK500-PSK500).
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Вкладка Igate

Функция  Igate  может  быть  активирована  на  вкладке  Igate.  Когда  она
включена, она может соединиться с сервером APRS Tier 2.

Все маяки и сообщения, принятые через Igate, будут отправлены в интернет-
инфраструктуру APRS.

Вкладка Rig control

Управление радиостанцией доступно в меню Preferences->Edit->Rig.
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Функция сканирования может быть включена отдельно. Вы можете ввести в
сканер  частоты  по  умолчанию.  Они  должны  вводиться  как  центральные
частоты в каналах, поскольку сканер использует Offset для расчёта частоты
приёма.  Таблицы  частот  известных  серверов  можно  хранить  в  каталоге
~/.pskmail.  Файлы  называются  called  SERVERCALL.chn,  и  содержат  список
частот, разделённых запятыми (в кГц). Пример PI4TUE.chn:
29250000,10147000,10147000,10147000,18106000

Если управление по CAT активировано в Fldigi, трансивер может управляться
из вкладки rigctl.

Поле SERVERCALL соответствует таблице частот сервера.

Кнопка  Set устанавливает  Rx  Current,  текущую  частоту  приёма,
соответствующую частоте, полученной по CAT в Fldigi.

Частота  приёма может  быть  изменена  кнопками  '+'  и  '-',  трансивер
откликается.

Кнопка SUMMON, призвать, несёт особую функцию

Если частоты RX Current и SERVERCALL отличаются, кнопка summon:
• Отправляет запрос на соединение на частоте в поле SERVERCALL;
• Прослушивает в ожидании подтверждения частоту в поле RX Current.
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Это  передаёт  серверу  просьбу  перейти  на  вашу  частоту  в  поле  RX
Current для приёма сообщений.

Разумеется,  это  работает  только  в  том  случае,  если  сервер  настроен  на
поддержку призывания.

Основное меню

Основное меню разделено на основные части:

• File
• Mode
• Preferences
• Mbox
• Info
• Identi.ca
• Link
• Map (В данное время не используется. Интерактивная карта, отображающая
данные APRS и не только, будет добавлена позже.)
• Help

File

Общие  действия,  такие,  как  подключение  к  серверу  или  клиенту,  очистка
списков и закрытие приложения.

• Connection - подключение
• Clear Inbox, or Outbox - очистка входящих, или исходящих
• Clear headers - очистка заголовков
• Clear bulletins - очистка рассылок
• Show pending transactions - показать очередь действий
• Set file up/download resume policy - настроить политику отправки/скачивания
файлов
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Mode

Управляет  основным  режимом  клиента  и  режимом  модема,  включая
настройки режимов для адаптивного изменения скорости при подключениях.
См. приложение А.

Preferences

Редактирование и сохранение параметров.

Mbox

Обработка локальных сообщений на сервере в ходе текущего подключения.
Под  локальными сообщениями мы понимаем сообщения,  адресованные как
user@server. Эти сообщения хранятся только локально, и не пересылаются на
другие  сервера PSKMail  (в  настоящее время).  Меню Mbox доступно только
тогда, когда на сервере есть ожидающие сообщения. Вы можете отправлять
сообщения, адресованные серверу, используя адрес CALL@SERVERCALL.

Команды Info

Команды для отправки на сервер в ходе текущего подключения.

Get Messages
Получить сообщения APRS, хранящиеся на findu.com

Get tidestations
Get list of tidestations close to current position

Get tide(###)
Get  tide  data  for  tide  station  ###,  use  get  tidestations  to  get  number  of  the
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wanted tide station.

Get Grib file
Здесь  клиент  отправляет  письмо  на  адрес  query@saildocs.com  с  запросом
данных grib. Сервер должен знать ваш обратный адрес (отправьте на сервер
свои учётные данные, если ещё не сделали этого). Файл grib доставляется на
ваш  облачный  почтовый  ящик.  Скачайте  его  и  просмотрите  с  помощью
'ZyGrib'.

Get IAC Fleetcodes
Это  обращение  к  NOAA  позволяет  получить  IAC  fleetcodes,  формирующие
карту атмосферного давления на данный момент в северной Атлантике. Файл
будет загружен клиентом и сохранён в ~/.pskmail/Downloads. Для просмотра
используйте ZyGrib.

Get IAC forecast
Это обращение к NOAA позволяет получить IAC fleetcodes, формирующие 24-
часовую  карту  атмосферного  давления  в  северной  Атлантике.  Файл  будет
загружен  клиентом  и  сохранён  в  ~/.pskmail/Downloads.  Для  просмотра
используйте ZyGrib.

Get WWV
Получить свежие геофизические оповещения wwv.txt от NOAA.

Get APRS stations
Получить  список  соседних  станций  APRS,  опираясь  на  клиентский  маркер
местоположения.

Get VHF/UHF Relays
Get VHF/UHF Relays from DARC.de centered at latest reported position.

Get camper sites
Get nearby camp sites from DARC.de. Works only in EU.

Get Server freqs
Получить список серверных частот с PSKmail wiki (серверная страница)

Get pskmail news
Получить свежие новости PSKMail с PSKmail wiki

Get web pages
Открыть веб-страницы, запрашиваемые через сервер

Identi.ca

Отправлять и получать обновления статуса канала PSKMail на сайте Identi.ca.
These updates will be sent to the PSKmail Identi.ca account so follow that to get
the news.
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Link

Обработка подключения к серверам
• Ping - выполнить проверку связи - Ctrl-P
• Inquire - выполнить проверку связи с конкретным сервером - Ctrl-I
• Quality - отобразить таблицу качества сигнала в основном терминале - Ctrl-Q
• Link - отправить запрос на подключение к серверу -Ctrl-L
• Update - обновить ваши почтовые данные на сервере - Ctrl-U
• Telnet - запустить клиент протокола telnet - Ctrl-T

Help

Открывает  интерактивную  справку,  составленную  на  основе  данного
руководства и отображает лицензионную информацию о приложении.

Картографическое приложение — не переведено

<...>
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Приложение A, выбор режима

В  нижеприведённой  таблице  сделана  попытка  свести  воедино  сведения  о
режимах передачи данных, используемых в PSKmail. Важно отметить, что это
пробная  редакция,  и  работа  ещё  в  процессе,  весьма  приветствуются
результаты испытаний и сведения, полезные для пополнения таблицы!

В любом случае,  из этой таблицы без сомнений можно сделать следующие
выводы:
-  быстрейшим режимом является  PSK500,  наивысшая  замеренная  скорость
составила  1862  знака/минуту  с  использованием  автоматического  запроса
повтора
- быстрейший режим для радиолюбителей США — PSK250
- самый медленный режим из перечисленных — THOR 8, 28 слов в минуту
- самый узкополосный режим — PSK63, ширина 63 Гц

Режим Скорость
(бод)

Слов в
минуту

(большие
буквы)

Слов в
минуту,
малые
буквы

Скорость
байт/

секунду*
Полоса

Сигнал/
шум,

минимум
**

Пригодность (1-3) для:
Примеча

ниеАЗИ
Слабых

сигналов
Высокой
скорости

Затухан
ий

PSK63 63 74 102 88 63 -2 3 3 3 3
PSK125 125 148 204 176 125 -1 3 3 3 3
PSK250 250 296 408 352 250 -1 3 3 2 3
PSK500 500 592 816 704 500 2 3 3 1 3

PSKR125 125 74 102 88 125 -8 2 2 3 2
PSKR250 250 148 204 176 250 -5 2 2 2 3
PSKR500 500 296 408 352 500 -3 2 3 1 3 ***

MFSK16 15,6 58 58 58 316 -8 1 1 3 1
MFSK32 31,25 120 120 120 630 -6 1 1 2 1

Domino 11 10,8 70 70 70 262 -7 3 2 3 3 ****
Domino 16 15,6 100 100 100 355 -6 3 2 3 3 ****
Domino 22 21,5 140 140 140 524 -5 3 2 2 3 ****

THOR8 7,8 28 28 28 346 -6 1 1 3 2
THOR11 10,7 40 40 40 262 -5 1 X 3 2
THOR16 15,6 58 58 58 355 1 X 3 2
THOR22 21,5 78 78 78 524 1 X 2 2

* - ориентировочная. Варикод и разные методы измерения усложняют замер.
** - найдено по возможности, большей частью в полосе 3 кГц
*** - наилучший режим по сочетанию характеристик?
**** - реализация в Fldigi несовершенна?

Вы можете заметить, что определённые популярные режимы в этой таблице
отсутствуют. Два из них — Olivia и MT63. Olivia непригодна к использованию в
PSKMail,  поскольку  не  поддерживает  полную  восьмибитную  кодировку
символов, а это значит, что стартовый и финишный фреймы <SOH> и <EOT>
не могут быть переданы.

Таблицы режимов для адаптивного асимметричного подключения

Начиная с версии 0.5 jPSKmail,  управление асмметричным подключением с
асимметричными режимами аплинка и даунлинка стало автоматическим.

Для этого был необходим ряд изменений в сервере и клиенте. Джон VK2ETA
сыграл в этом деле важную роль. Теперь на клиенте может быть установлена
таблица  режимов,  и  сервер будет действовать  в  соответствии с  ней.  Могут
быть установлены разные режимы на приём и передачу, сервер будет менять
их в соответствии с качеством канала.
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Таблица  включает  наиболее  популярные режимы,  захватывающие широкий
диапазон скорости, чувствительности и надёжности.

Возможная таблица режимов:
PSK500 – PSK500R – PSK250R – THOR22 – MFSK16 – THOR8 — THOR4

Режимы в  этой  таблице  перечислены от  быстрого  к  медленному,  от  менее
чувствительных  и  надёжных  к  более  чувствительным  и  надёжным.  Сервер
знает соотношение сигнал/шум и скорость скачивания у клиента, и выбирает
режимы,  позволяющие наилучшее использование  канала  данного  качества.
Начальные режимы приёма и передачи устанавливаются на клиенте заранее,
до установки соединения. Это (всё ещё) под контролем оператора.

До  отправки  пакета  сервер  принимает  решение,  смена  режима  возможна
(вверх)  или  необходима  (вниз),  опираясь  на  известное  соотношение
сигнал/шум  подключений  в  обоих  направлениях,  и  истории  использования
автоматического  запроса  повтора.  В  этих  случаях  сервер  переключает
режимы по таблице вверх или вниз.

Выбор режима APRS

Для  функций  APRS  наилучшим  режимом  обычно  является  режим  канала,
установленный  по  умолчанию.  В  Европе  это  PSK500,  в  США  серверы
используют PSK250, если только не работают в сетях MARS.

В  случае,  если  станция  не  устанавливает  связь  в  режиме  по  умолчанию,
возможно переключиться на менее скоростной режим, со включённым RSID.
RSID на передачу может быть переключён в Fldigi  вручную. По получении
подтверждения от сервера ID клиента на передачу может быть переключён
сервером обратно. Так предотвращается неразбериха режимов на частоте.

Управление шумоподавлением

Шумоподавитель в Fldigi управляется программой-клиентом jPSKmail. Уровень
шумоподавления  выбирается  в  соответствии  с  режимом  работы.  Если
шумоподавитель  случайно  был  отключён,  jPSKmail  автоматически  включит
его.  Без  шумоподавителя  невозможна  работа  функции  DCD,  и  клиент  не
сможет маячить, если шумоподавитель открыт.

Приложение B, протокол ARQ в PSKMail — не переведено

Спецификация протокола автоматического запроса повтора (ARQ) в PSKmail
(3я черновая редакция)
<...>
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